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Liptikl UI

Introduction

You are in control...

... but you can learn to delegate

Important:

Liptikl™ 1
Lyric Generator 

you are here » home » liptikl 1 » user guide » introduction

forum  | store  | news  | about  | help  | search  | terms of use  | privacy  | accessibility  | site map  | contact  | © 2010 Intermorphic. E&OE.

Liptikl is a powerful "ideas generator" and is a welcome
addition to the creative writer's s armoury of tools. It can help
you come up with new ideas for lyrics and poems or indeed
any other area of creative writing. Try it and see!

Liptikl lets your computer create lyric ideas that are inspired
by seed words and phrases that you give it.

Your job is to use the Liptikl user interface to guide Liptikl to
finding interesting combinations of words which you can then
use in real-world lyrics or poems.

Liptikl draws on the Zen koan tradition in that there seems no
obvious way it generates its ideas, and it is pronounced "lip –
tickle".

Liptikl is created by Pete Cole and Tim Cole, creators of the
2001 BAFTA-award winning SSEYO Koan Interactive Audio
Platform, and the 2005 BAFTA-award winning SSEYO
miniMIXA.

When you ask Liptikl to generate a verse, Liptikl takes your inputs, and combines them according to its internal
rule-base of how lyrics work. The resultant lyric can then be modified by you, tweaked and regenerated in whole
or part.

You can use Liptikl to build-up entire generative lyrics, or simply as an idea generator when you get stuck. Use it
to combine ideas from previous works; see what you can come-up with!

There are many internal rules used to create lyrics within liptikl. When the Liptikl lyric engine is figuring-out what
to do, it combines all these rules together in combination with your source material, and respects them as best it
can, but ultimately Liptikl makes its own choice as to exactly what to do. In other words, you can give the engine
brain lots of guidance, but ultimately (like a child) you let Liptikl makes the final, detailed decisions as to what to
do.

The reason this all works, is that at its heart, the Liptikl lyric engine uses random events in combination with a
powerful set of rules. How you interpret what you read is filtered through your own internal knowledge of
language. This combination of chance and logic is what allows Liptikl to keep coming-up with ideas that are
fresh, interesting and unpredictable.

One of the things that a first user of Liptikl might find, is that delegating responsibility to a lyric engine feels like
a weird thing to do!

However, give this a little time. Many, many users of our generative software have found that this process of
learning to sit-back and delegate responsibility for small details to a generative engine is extremely liberating.
You instead start to focus on other things, like tweaking the words used to generate the lyrics, trying different
inputs maybe from the built-in thesaurus searching, or just sitting back and being entertained or baffled by what
Liptikl creates, waiting for nuggets of beautiful ideas to appear when you least expect them. Yes, you can focus
on details in Liptikl, but you can also take more of a view of a gardener's view to creating lyrics: casting word
seeds on the ground, and selecting those ideas which blossom and discarding those that don't appeal.

We respect copyright and strongly encourage you to do the same. That means if you use Liptikl to come up
with a lyric you like, make sure that it does not infringe the copyright of any of your source material.
Liptikl is pretty good at "shuffling words", but it is just a tool for you to use to generate ideas. It is
ultimately your responsibility to make sure you are not infringing anyone elses copyright.
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Installation

Installing Liptikl on Windows:

1. Save the liptikl_win32.zip file to your Windows desktop
2. Use Windows Explorer to look inside the file (or use a tool like WinZip).
3. Run the liptikl_win32_setup.exe file, and complete the installation!

Installing Noatikl on Mac OS X:

1. Save the liptikl_mac_dmg.zip file to your Mac desktop
2. Double click on it, creating a Intermorphic - liptikl.dmg icon.
3. Double click on that; opens a folder containing 1 icon.
4. Double click on the icon; this opens a folder containing an icon for the Liptikl installer - run that file to

complete the installation!.
5. You'll find the Liptikl application in your Applications folder under Finder; if you want to make it as easy to

find as possible, you can drag it direct to your Dock for future easy access!
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Product Key

License discussion - dual use
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When you first run Liptikl, you'll get reminders to enter your product key. After using Liptikl for a number of
days, the evaluation period will expire. From that point onwards, you'll have to buy a key from Intermorphic in
order to continue using liptikl.

Once you've received your Liptikl product key, you must select Help -> Liptikl Product Key, and enter your details
into the three fields. Press the appropriate key to check and confirm your details!

When you buy your key, you might be sent a “keep you going” key that you can enter immediately while we check
your details. This key will keep Liptikl running for a few more days. Be sure to enter the full product key when
you receive it, in order to keep using liptikl.

As many people use both a Mac and a Windows machine in their home studio, we allow you to install Liptikl on
two machines (which could be running different operating system versions) but you are only allowed to use Liptikl
on one machine at a time. You must make sure you understand the End User License agreement and how it
allows you to use your license.

Liptikl 1
Overview

Download

User Quotes

EULA

Forum

User Guide PDF
USER GUIDE

 Contents

 Introduction

 Installation

 Product Key

 Quick Start

 Tutorial

 Idea Text Options

 Save, Import & Export

http://www.intermorphic.com/
http://forum.intermorphic.com/
http://www.intermorphic.com/store.html
http://www.intermorphic.com/download/index.html
http://www.intermorphic.com/news/index.html
http://www.intermorphic.com/help.html
http://www.intermorphic.com/company/index.html
http://www.intermorphic.com/search.html
http://www.intermorphic.com/tools/noatikl/index.html
http://www.intermorphic.com/tools/noatikl/index.html
http://www.intermorphic.com/tools/noatikl/index.html
http://www.intermorphic.com/tools/liptikl/index.html
http://www.intermorphic.com/tools/liptikl/index.html
http://www.intermorphic.com/tools/liptikl/index.html
http://www.intermorphic.com/tools/mixtikl/index.html
http://www.intermorphic.com/tools/mixtikl/index.html
http://www.intermorphic.com/tools/mixtikl/index.html
http://www.intermorphic.com/tools/partikl/index.html
http://www.intermorphic.com/tools/partikl/index.html
http://www.intermorphic.com/tools/partikl/index.html
http://www.intermorphic.com/tools/content/index.html
http://www.intermorphic.com/tools/content/index.html
http://www.intermorphic.com/tools/content/index.html
http://www.intermorphic.com/tools/liptikl/index.html
http://www.intermorphic.com/rss.xml
http://www.intermorphic.com/index.html
http://www.intermorphic.com/tools/liptikl/index.html
http://forum.intermorphic.com/
http://www.intermorphic.com/store.html
http://www.intermorphic.com/news/index.html
http://www.intermorphic.com/company/index.html
http://www.intermorphic.com/help.html
http://www.intermorphic.com/search.html
http://www.intermorphic.com/company/termsOfUse.html
http://www.intermorphic.com/company/privacy.html
http://www.intermorphic.com/company/accessibility.html
http://www.intermorphic.com/sitemap.html
http://www.intermorphic.com/company/contact.html
http://www.intermorphic.com/tools/liptikl/eula.html
http://www.addthis.com/bookmark.php?v=250&username=imtim
http://www.intermorphic.com/scripts/menus/../../tools/liptikl/index.html
http://www.intermorphic.com/scripts/menus/../../download/index.html
http://www.intermorphic.com/scripts/menus/../../tools/liptikl/quotes.html
http://www.intermorphic.com/scripts/menus/../../tools/liptikl/eula.html
http://forum.intermorphic.com/viewforum.php?f=26


forum store downloads news help about search

Noatikl
music

Liptikl
lyrics

Mixtikl
mixer

Partikl
synth

Tiklpak
content

Liptikl 1 User Guide back | next

Quick Start

Pete's Example

often floating my I'm,
me! people or Good,
examples good have than,
grab lyrics which type.

I'm often floating on my own
good people pass me by
examples good have than,
grab lyrics which type.

I'm often floating on my own,
good people pass me by,
sub-consciousness floating starter to,
I that guess try.

I'm often floating on my own,
good people pass me by,
Feel my sub-consciousness caving-in,
I that guess cry.

I'm often floating on my own,
good people pass me by,
Feel my sub-consciousness caving-in,
my that listening try I cry.

I'm often floating on my own,
good people pass me by,
Feel my sub-consciousness caving-in,
Their listening makes me cry.

Liptikl™ 1
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Here is some general background on how to go about using Liptikl to create lyrics.

To create a lyric, simply type in some rough fragments of song lyrics or other source text, paste in some other
media, and type in a few more words that you like. This is like taking some good basic ingredients, and throwing
them in the mixing bowl.

Then press generate a few times. You'll like some of the word combinations it throws together (remembering
Liptikl tries to rhyme where it can); lock those words in place, and keep going a few more times; locking or
unlocking as you see stuff you like.

Then you could change some words by hand, look up a couple via the thesaurus, paste them in to the source,
run a few more times and blam there you have it. If you're lucky. Hopefully this will take only 4 or 5 minutes to
come-up with a useful verse, without much thought; but of course we're used to using the tool, which helps!

The key thing with Liptikl is to involve yourself in the decision making, acting like a gardener, weeding-out the
bits you don't like and tidying-up the bits you do.

So: start with good source words. Keep generating quickly until you see something pop-out you like. Lock-down
the bits you do. Keep generating. Don't be afraid to direct edit what you see what you realise your own words
can help - and lock-down your direct edits. Keep generating. And don't forget you can unlock bits you're no
longer happy with, to release Liptikl to create more ideas for you.

Good examples (that work for me!) are things like film titles, or phrases I like from a movie or book, and I also
often just type in words that come to my head that presumably have just been floating under my sub-
consciousness. If I'm listening to music (which I often am!) I'll type-in some mis-remembered lyrics from the
artist. Or just do a grab from google searching for a few words. I don't spend more than a few minutes pulling
ideas together. I guess other people might start from some lyrics they've been working on as a starter point. I'm
no good at that, so start from a clean slate!

Pressing generate a few times gives me ideas. Here's an example of how to generate some ideas. I typed-in the
above paragraph of instructions, pressed generate, and got:

I instantly saw a pattern in there, and changed the top two lines (left the second two as they are):

And locked-down every word in the top two lines.

I pressed generate a couple of times, realised I didn't have anything that rhymed with by! So, added a few words:
try/deny/sky/fly cry. After a couple of presses I generated the following:

Changed 3rd line by hand to this below (and locked the 3rd line, and the final word in the 4th line):

Generated a couple of times, realised I wanted a final longer line, updated rule from 6 5 4 4 to 6 5 4 6,
generated a couple more times,

And thought... aha! And modified the final line by hand to get my lyric:
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Tutorial

Starting afresh

1 - Ideas

2 - Lyrics

Liptikl™ 1
Lyric Generator 
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From the Liptikl menu, select File -> New.

This presents you with a window, containing various buttons, lists and text boxes.

Working your way around the user interface, you'll see that there are various numbered areas. In general, you put
your data in to the numbered areas in order, and work your way through from lowest number to highest. Once
you reach the end, you have some lyrics!

Liptikl generates real lyrics, by examining text in the three text fields in the Ideas section, and generating lyrics in
response to the generate button. It mashes together words from each of the ideas boxes to come up with its
suggestions.

Tip: The more interesting the source material you use in your ideas boxes, the more interesting the lyric
suggestions generated! You can think of your favourite source materials like spices or ingredients, and
then build up a collection of your favourites to add when you want. You can then add as little or as much as
you like!

So, start by putting some ideas into any or all of the three fields.

You can type the data in directly, or paste-in some text from any source. There are also various other options
you can use, which are on a pop-up menu that you can get at either by either right clicking (Windows) or control
clicking (Mac).

Once you have some ideas in, move on to the Lyrics area!

The first thing to do here is probably just to click on the Create Lyrics button

You'll see the first verse of your lyric appear in the text box next to it (provided you have first added some words
to at least one of the ideas text boxes). You might, or might not, like what you see, but you're just starting to
play with Liptikl, and there's no telling what you might come up with! Press Create Lyrics a few more times if you
want!

The Lyric Rule combo box lets you change the rules used to create your lyrics. The rule consists of a series of
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3 - Verses

Lyric options

Click on a word:

Lock Word

Unlock Word

Thesaurus

Dictionary

Search

numbers. Each number stands for the number of words to put in each line of the lyric. Each number stands for
one line of text. For example, the number 3 4 5 6 would be four lines (as there are four numbers!). The first line
would have three words, the second would have 4 words, the third would have five words, and the fourth would
have six words.

You can easily create and use any rule you want, just type a new rule into the Lyric Rule combo box, press the
Create Lyrics button, and see what happens!

The Verses area contains the verses of your lyric.

Assuming you come-up with a verse you like, press the Add button to have it appear in your verses list. Add as
many verses as you want!

Alternatively, you can press the Replace button if you want to copy-down the lyric from above to replace the
currently selected verse in the list.

You can press the Up and Down arrow buttons to move your verses up and down in the list.

You can also delete your verses with the Delete and Delete All buttons.

Finally, press the Edit button to copy your currently selected list item up to the Lyric area where you can do some
more work on it!

One of the wonderful things about Liptikl is that you have a lot of options to help you work creatively with your
text.

To access these options, you need to access a pop-up menu that you can get at either by either right clicking
(Windows) or control clicking (Mac) on the Lyric editor.

Prevents the clicked word in the lyric from being changed when you next click on the Generate Lyrics button.

Allows the clicked word in the lyric to be changed when you next click on the Generate Lyrics button.

Search via a thesaurus engine for the selected word (e.g. "ThisWord" in the screenshot above)! Selecting this
option launches your web browser to display a webpage with a "Go" button. Pressing that button automatically
loads a webpage that uses your selected word.

Note: if you select any of the "other thesaurus sites" listed below the Go button, which are there for your easy
reference, then these do not automatically work with your selected word.

Search via a dictionary engine for the selected word (e.g. "ThisWord" in the screenshot above)! Selecting this
option launches your web browser to display a webpage with a "Go" button. Pressing that button automatically
loads a webpage that uses your selected word.

Note: if you select any of the "other dictionary sites" listed below the Go button, which are there for your easy
reference, then these do not automatically work with your selected word.

Search via a search engine for the selected word (e.g. "ThisWord" in the screenshot above)! Selecting this option
launches your web browser to display a webpage with a "Go" button. Pressing that button automatically loads a
webpage that uses your selected word.

Note: if you select any of the "other search sites" listed below the Go button, which are there for your easy
reference, then these do not automatically work with your selected word.



Search for all words

Unlock all words

Lock all words

Edit...
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Search via a search engine for all the words in the lyrics, in a similar way to search above.

Allows all words in the lyric to be changed when you next click on the Generate Lyrics button.

Prevents all words in the lyric from being changed when you next click on the Generate Lyrics button.

Selecting this presents the following options for copy/paste etc.

The Ideas and Lyrics text boxes in Liptikl are editable, which means you can move words around by cutting and
pasting, or even edit or manually add in new words. It is very useful to be able to do this, as words you want to
use may appear, but not in the position you want them to - so you simply move them!
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Idea Text Options

Click on a word:

Thesaurus

Dictionary

Search

Search for all words

Edit...
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Lyric Generator 
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One of the wonderful things about Liptikl is that you also have a lot of options to help you work creatively with
your "source text".

To access these options, you need to access a pop-up menu that you can get at either by either right clicking
(Windows) or control clicking (Mac) on one of the Text fields in the Ideas area, or a word in this area.

Tip: Why not try using text from some current news items in the ideas box - that way you can make sure
you use words that are current, and some interesting themes can seemingly come out of nothing!

Tip: Liptikl has a better chance at shuffling the more words are in your source content. Obviously, if your
source content is only one word, then Liptikl can only choose one word! So make sure you give Liptikl lots
of different words to choose from.

Search via a thesaurus engine for the selected word (e.g. "ThisWord" in the screenshot above)! Selecting this
option launches your web browser to display a webpage with a "Go" button. Pressing that button automatically
loads a webpage that uses your selected word.

Note: if you select any of the "other thesaurus sites" listed below the Go button, which are there for your easy
reference, then these do not automatically work with your selected word.

Search via a dictionary engine for the selected word (e.g. "ThisWord" in the screenshot above)! Selecting this
option launches your web browser to display a webpage with a "Go" button. Pressing that button automatically
loads a webpage that uses your selected word.

Note: if you select any of the "other dictionary sites" listed below the Go button, which are there for your easy
reference, then these do not automatically work with your selected word.

Search via a search engine for the selected word (e.g. "ThisWord" in the screenshot above)! Selecting this option
launches your web browser to display a webpage with a "Go" button. Pressing that button automatically loads a
webpage that uses your selected word.

Note: if you select any of the "other search sites" listed below the Go button, which are there for your easy
reference, then these do not automatically work with your selected word.

Search via a search engine for all the words in the lyrics, in a similar way to search above.

Selecting this presents the following options for copy/paste etc.
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The Ideas text boxes in Liptikl are editable, which means you can move words around by cutting and pasting, or
even edit or manually add in new words. It is very useful to be able to do this, as you may want to add, edit or
delete words from your source material

You will see this if you select a number of words (by dragging the mouse over the words whilst holding the left
mouse button down). Search via a search engine for all the words in the lyrics, in a similar way to search above.

Presents Open (which allows you to open a text file and load the data in that file into your text field), and Save
(which allows you to save your text field to a text file).

Various options for copy/paste etc. as outlined above.

Presents Open (which allows you to open a text file and load the data in that file into your text field), and Save
(which allows you to save your text field to a text file).
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You can save your Liptikl session to a file with a .Liptikl file extension, through the File menu Save or Save As
options.

You can import a pre-existing lyric into Liptikl from a text file, with a .txt file extension, through the File menu
Export option. Note that the Import option requires each of your verses to be separated by at least one blank line.
If you try to import a large file, Liptikl might take a very long time to respond as it analyses the file; please be
patient! If you have a file in some format that is specific to a word-processor application, then you'll first have to
save the lyric as a text file before trying to import it into liptikl.

Once you've come up with a lyrical idea that you're happy with, you can export your generated lyrics to a text file,
with a .txt file extension, through the File menu Export option. You can then edit the file with your favourite word
processor application!

Liptikl 1
Overview

Download

User Quotes

EULA

Forum

User Guide PDF
USER GUIDE

 Contents

 Introduction

 Installation

 Product Key

 Quick Start

 Tutorial

 Idea Text Options

 Save, Import & Export

http://www.intermorphic.com/
http://forum.intermorphic.com/
http://www.intermorphic.com/store.html
http://www.intermorphic.com/download/index.html
http://www.intermorphic.com/news/index.html
http://www.intermorphic.com/help.html
http://www.intermorphic.com/company/index.html
http://www.intermorphic.com/search.html
http://www.intermorphic.com/tools/noatikl/index.html
http://www.intermorphic.com/tools/noatikl/index.html
http://www.intermorphic.com/tools/noatikl/index.html
http://www.intermorphic.com/tools/liptikl/index.html
http://www.intermorphic.com/tools/liptikl/index.html
http://www.intermorphic.com/tools/liptikl/index.html
http://www.intermorphic.com/tools/mixtikl/index.html
http://www.intermorphic.com/tools/mixtikl/index.html
http://www.intermorphic.com/tools/mixtikl/index.html
http://www.intermorphic.com/tools/partikl/index.html
http://www.intermorphic.com/tools/partikl/index.html
http://www.intermorphic.com/tools/partikl/index.html
http://www.intermorphic.com/tools/content/index.html
http://www.intermorphic.com/tools/content/index.html
http://www.intermorphic.com/tools/content/index.html
http://www.intermorphic.com/tools/liptikl/index.html
http://www.intermorphic.com/rss.xml
http://www.intermorphic.com/index.html
http://www.intermorphic.com/tools/liptikl/index.html
http://forum.intermorphic.com/
http://www.intermorphic.com/store.html
http://www.intermorphic.com/news/index.html
http://www.intermorphic.com/company/index.html
http://www.intermorphic.com/help.html
http://www.intermorphic.com/search.html
http://www.intermorphic.com/company/termsOfUse.html
http://www.intermorphic.com/company/privacy.html
http://www.intermorphic.com/company/accessibility.html
http://www.intermorphic.com/sitemap.html
http://www.intermorphic.com/company/contact.html
http://www.addthis.com/bookmark.php?v=250&username=imtim
http://www.intermorphic.com/scripts/menus/../../tools/liptikl/index.html
http://www.intermorphic.com/scripts/menus/../../download/index.html
http://www.intermorphic.com/scripts/menus/../../tools/liptikl/quotes.html
http://www.intermorphic.com/scripts/menus/../../tools/liptikl/eula.html
http://forum.intermorphic.com/viewforum.php?f=26


Embedded Secure Document
The file http://www.intermorphic.com/tools/liptikl/doc/liptikl1UserGuide.pdf is a secure
document that has been embedded in this document. Double click the pushpin to view.




forum store downloads news help about search


Noatikl
MIDI


Liptikl
lyrics


Mixtikl
mixer


Partikl
synth


Tiklpak
content


Liptikl UI


Liptikl 1 User Guide


Introduction


You are in control...


... but you can learn to delegate


Important:


Liptikl™ 1
Lyric Generator 


you are here » home » liptikl 1 » user guide » introduction
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Liptikl is a powerful "ideas generator" and is a welcome
addition to the creative writer's s armoury of tools. It can help
you come up with new ideas for lyrics and poems or indeed
any other area of creative writing. Try it and see!


Liptikl lets your computer create lyric ideas that are inspired
by seed words and phrases that you give it.


Your job is to use the Liptikl user interface to guide Liptikl to
finding interesting combinations of words which you can then
use in real-world lyrics or poems.


Liptikl draws on the Zen koan tradition in that there seems no
obvious way it generates its ideas, and it is pronounced "lip –
tickle".


Liptikl is created by Pete Cole and Tim Cole, creators of the
2001 BAFTA-award winning SSEYO Koan Interactive Audio
Platform, and the 2005 BAFTA-award winning SSEYO
miniMIXA.


When you ask Liptikl to generate a verse, Liptikl takes your inputs, and combines them according to its internal
rule-base of how lyrics work. The resultant lyric can then be modified by you, tweaked and regenerated in whole or
part.


You can use Liptikl to build-up entire generative lyrics, or simply as an idea generator when you get stuck. Use it
to combine ideas from previous works; see what you can come-up with!


There are many internal rules used to create lyrics within liptikl. When the Liptikl lyric engine is figuring-out what
to do, it combines all these rules together in combination with your source material, and respects them as best it
can, but ultimately Liptikl makes its own choice as to exactly what to do. In other words, you can give the engine
brain lots of guidance, but ultimately (like a child) you let Liptikl makes the final, detailed decisions as to what to
do.


The reason this all works, is that at its heart, the Liptikl lyric engine uses random events in combination with a
powerful set of rules. How you interpret what you read is filtered through your own internal knowledge of
language. This combination of chance and logic is what allows Liptikl to keep coming-up with ideas that are fresh,
interesting and unpredictable.


One of the things that a first user of Liptikl might find, is that delegating responsibility to a lyric engine feels like a
weird thing to do!


However, give this a little time. Many, many users of our generative software have found that this process of
learning to sit-back and delegate responsibility for small details to a generative engine is extremely liberating. You
instead start to focus on other things, like tweaking the words used to generate the lyrics, trying different inputs
maybe from the built-in thesaurus searching, or just sitting back and being entertained or baffled by what Liptikl
creates, waiting for nuggets of beautiful ideas to appear when you least expect them. Yes, you can focus on
details in Liptikl, but you can also take more of a view of a gardener's view to creating lyrics: casting word seeds
on the ground, and selecting those ideas which blossom and discarding those that don't appeal.


We respect copyright and strongly encourage you to do the same. That means if you use Liptikl to come up with a
lyric you like, make sure that it does not infringe the copyright of any of your source material. Liptikl is pretty
good at "shuffling words", but it is just a tool for you to use to generate ideas. It is ultimately your responsibility
to make sure you are not infringing anyone elses copyright.
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Installation


Installing Liptikl on Windows:


1. Save the liptikl_win32.zip file to your Windows desktop
2. Use Windows Explorer to look inside the file (or use a tool like WinZip).
3. Run the liptikl_win32_setup.exe file, and complete the installation!


Installing Noatikl on Mac OS X:


1. Save the liptikl_mac_dmg.zip file to your Mac desktop
2. Double click on it, creating a Intermorphic - liptikl.dmg icon.
3. Double click on that; opens a folder containing 1 icon.
4. Double click on the icon; this opens a folder containing an icon for the Liptikl installer - run that file to


complete the installation!.
5. You'll find the Liptikl application in your Applications folder under Finder; if you want to make it as easy to


find as possible, you can drag it direct to your Dock for future easy access!


Liptikl™ 1
Lyric Generator 


you are here » home » liptikl 1 » user guide » installation


forum  | store  | news  | about  | help  | search  | terms of use  | privacy  | accessibility  | site map  | contact  | © 2010 Intermorphic. E&OE.


Now that you have all that background behind you, the next thing to do is to install liptikl!
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When you first run Liptikl, you'll get reminders to enter your product key. After using Liptikl for a number of days,
the evaluation period will expire. From that point onwards, you'll have to buy a key from Intermorphic in order to
continue using liptikl.


Once you've received your Liptikl product key, you must select Help -> Liptikl Product Key, and enter your details
into the three fields. Press the appropriate key to check and confirm your details!


When you buy your key, you might be sent a “keep you going” key that you can enter immediately while we check
your details. This key will keep Liptikl running for a few more days. Be sure to enter the full product key when you
receive it, in order to keep using liptikl.


As many people use both a Mac and a Windows machine in their home studio, we allow you to install Liptikl on two
machines (which could be running different operating system versions) but you are only allowed to use Liptikl on
one machine at a time. You must make sure you understand the End User License agreement and how it allows you
to use your license.
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Quick Start


Pete's Example


often floating my I'm,
me! people or Good,
examples good have than,
grab lyrics which type.


I'm often floating on my own
good people pass me by
examples good have than,
grab lyrics which type.


I'm often floating on my own,
good people pass me by,
sub-consciousness floating starter to,
I that guess try.


I'm often floating on my own,
good people pass me by,
Feel my sub-consciousness caving-in,
I that guess cry.


I'm often floating on my own,
good people pass me by,
Feel my sub-consciousness caving-in,
my that listening try I cry.


I'm often floating on my own,
good people pass me by,
Feel my sub-consciousness caving-in,
Their listening makes me cry.
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Here is some general background on how to go about using Liptikl to create lyrics.


To create a lyric, simply type in some rough fragments of song lyrics or other source text, paste in some other
media, and type in a few more words that you like. This is like taking some good basic ingredients, and throwing
them in the mixing bowl.


Then press generate a few times. You'll like some of the word combinations it throws together (remembering
Liptikl tries to rhyme where it can); lock those words in place, and keep going a few more times; locking or
unlocking as you see stuff you like.


Then you could change some words by hand, look up a couple via the thesaurus, paste them in to the source, run
a few more times and blam there you have it. If you're lucky. Hopefully this will take only 4 or 5 minutes to come-
up with a useful verse, without much thought; but of course we're used to using the tool, which helps!


The key thing with Liptikl is to involve yourself in the decision making, acting like a gardener, weeding-out the bits
you don't like and tidying-up the bits you do.


So: start with good source words. Keep generating quickly until you see something pop-out you like. Lock-down
the bits you do. Keep generating. Don't be afraid to direct edit what you see what you realise your own words can
help - and lock-down your direct edits. Keep generating. And don't forget you can unlock bits you're no longer
happy with, to release Liptikl to create more ideas for you.


Good examples (that work for me!) are things like film titles, or phrases I like from a movie or book, and I also
often just type in words that come to my head that presumably have just been floating under my sub-
consciousness. If I'm listening to music (which I often am!) I'll type-in some mis-remembered lyrics from the artist.
Or just do a grab from google searching for a few words. I don't spend more than a few minutes pulling ideas
together. I guess other people might start from some lyrics they've been working on as a starter point. I'm no
good at that, so start from a clean slate!


Pressing generate a few times gives me ideas. Here's an example of how to generate some ideas. I typed-in the
above paragraph of instructions, pressed generate, and got:


I instantly saw a pattern in there, and changed the top two lines (left the second two as they are):


And locked-down every word in the top two lines.


I pressed generate a couple of times, realised I didn't have anything that rhymed with by! So, added a few words:
try/deny/sky/fly cry. After a couple of presses I generated the following:


Changed 3rd line by hand to this below (and locked the 3rd line, and the final word in the 4th line):


Generated a couple of times, realised I wanted a final longer line, updated rule from 6 5 4 4 to 6 5 4 6, generated
a couple more times,


And thought... aha! And modified the final line by hand to get my lyric:
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Tutorial


Starting afresh


1 - Ideas


2 - Lyrics


Liptikl™ 1
Lyric Generator 
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From the Liptikl menu, select File -> New.


This presents you with a window, containing various buttons, lists and text boxes.


Working your way around the user interface, you'll see that there are various numbered areas. In general, you put
your data in to the numbered areas in order, and work your way through from lowest number to highest. Once you
reach the end, you have some lyrics!


Liptikl generates real lyrics, by examining text in the three text fields in the Ideas section, and generating lyrics in
response to the generate button. It mashes together words from each of the ideas boxes to come up with its
suggestions.


Tip: The more interesting the source material you use in your ideas boxes, the more interesting the lyric
suggestions generated! You can think of your favourite source materials like spices or ingredients, and then build
up a collection of your favourites to add when you want. You can then add as little or as much as you like!


So, start by putting some ideas into any or all of the three fields.


You can type the data in directly, or paste-in some text from any source. There are also various other options you
can use, which are on a pop-up menu that you can get at either by either right clicking (Windows) or control
clicking (Mac).


Once you have some ideas in, move on to the Lyrics area!


The first thing to do here is probably just to click on the Create Lyrics button


You'll see the first verse of your lyric appear in the text box next to it (provided you have first added some words
to at least one of the ideas text boxes). You might, or might not, like what you see, but you're just starting to
play with Liptikl, and there's no telling what you might come up with! Press Create Lyrics a few more times if you
want!


The Lyric Rule combo box lets you change the rules used to create your lyrics. The rule consists of a series of
numbers. Each number stands for the number of words to put in each line of the lyric. Each number stands for one
line of text. For example, the number 3 4 5 6 would be four lines (as there are four numbers!). The first line would
have three words, the second would have 4 words, the third would have five words, and the fourth would have six
words.
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3 - Verses


Lyric options


Click on a word:


Lock Word


Unlock Word


Thesaurus


Dictionary


Search


Search for all words


You can easily create and use any rule you want, just type a new rule into the Lyric Rule combo box, press the
Create Lyrics button, and see what happens!


The Verses area contains the verses of your lyric.


Assuming you come-up with a verse you like, press the Add button to have it appear in your verses list. Add as
many verses as you want!


Alternatively, you can press the Replace button if you want to copy-down the lyric from above to replace the
currently selected verse in the list.


You can press the Up and Down arrow buttons to move your verses up and down in the list.


You can also delete your verses with the Delete and Delete All buttons.


Finally, press the Edit button to copy your currently selected list item up to the Lyric area where you can do some
more work on it!


One of the wonderful things about Liptikl is that you have a lot of options to help you work creatively with your
text.


To access these options, you need to access a pop-up menu that you can get at either by either right clicking
(Windows) or control clicking (Mac) on the Lyric editor.


Prevents the clicked word in the lyric from being changed when you next click on the Generate Lyrics button.


Allows the clicked word in the lyric to be changed when you next click on the Generate Lyrics button.


Search via a thesaurus engine for the selected word (e.g. "ThisWord" in the screenshot above)! Selecting this
option launches your web browser to display a webpage with a "Go" button. Pressing that button automatically
loads a webpage that uses your selected word.


Note: if you select any of the "other thesaurus sites" listed below the Go button, which are there for your easy
reference, then these do not automatically work with your selected word.


Search via a dictionary engine for the selected word (e.g. "ThisWord" in the screenshot above)! Selecting this
option launches your web browser to display a webpage with a "Go" button. Pressing that button automatically
loads a webpage that uses your selected word.


Note: if you select any of the "other dictionary sites" listed below the Go button, which are there for your easy
reference, then these do not automatically work with your selected word.


Search via a search engine for the selected word (e.g. "ThisWord" in the screenshot above)! Selecting this option
launches your web browser to display a webpage with a "Go" button. Pressing that button automatically loads a
webpage that uses your selected word.


Note: if you select any of the "other search sites" listed below the Go button, which are there for your easy
reference, then these do not automatically work with your selected word.


Search via a search engine for all the words in the lyrics, in a similar way to search above.







Unlock all words


Lock all words


Edit...
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Allows all words in the lyric to be changed when you next click on the Generate Lyrics button.


Prevents all words in the lyric from being changed when you next click on the Generate Lyrics button.


Selecting this presents the following options for copy/paste etc.


The Ideas and Lyrics text boxes in Liptikl are editable, which means you can move words around by cutting and
pasting, or even edit or manually add in new words. It is very useful to be able to do this, as words you want to
use may appear, but not in the position you want them to - so you simply move them!
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Idea Text Options


Click on a word:


Thesaurus


Dictionary


Search


Search for all words


Edit...


Liptikl™ 1
Lyric Generator 


you are here » home » liptikl 1 » user guide » idea text options


One of the wonderful things about Liptikl is that you also have a lot of options to help you work creatively with
your "source text".


To access these options, you need to access a pop-up menu that you can get at either by either right clicking
(Windows) or control clicking (Mac) on one of the Text fields in the Ideas area, or a word in this area.


Tip: Why not try using text from some current news items in the ideas box - that way you can make sure you use
words that are current, and some interesting themes can seemingly come out of nothing!


Tip: Liptikl has a better chance at shuffling the more words are in your source content. Obviously, if your source
content is only one word, then Liptikl can only choose one word! So make sure you give Liptikl lots of different
words to choose from.


Search via a thesaurus engine for the selected word (e.g. "ThisWord" in the screenshot above)! Selecting this
option launches your web browser to display a webpage with a "Go" button. Pressing that button automatically
loads a webpage that uses your selected word.


Note: if you select any of the "other thesaurus sites" listed below the Go button, which are there for your easy
reference, then these do not automatically work with your selected word.


Search via a dictionary engine for the selected word (e.g. "ThisWord" in the screenshot above)! Selecting this
option launches your web browser to display a webpage with a "Go" button. Pressing that button automatically
loads a webpage that uses your selected word.


Note: if you select any of the "other dictionary sites" listed below the Go button, which are there for your easy
reference, then these do not automatically work with your selected word.


Search via a search engine for the selected word (e.g. "ThisWord" in the screenshot above)! Selecting this option
launches your web browser to display a webpage with a "Go" button. Pressing that button automatically loads a
webpage that uses your selected word.


Note: if you select any of the "other search sites" listed below the Go button, which are there for your easy
reference, then these do not automatically work with your selected word.


Search via a search engine for all the words in the lyrics, in a similar way to search above.


Selecting this presents the following options for copy/paste etc.
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Edit...


Idea text file...
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The Ideas text boxes in Liptikl are editable, which means you can move words around by cutting and pasting, or
even edit or manually add in new words. It is very useful to be able to do this, as you may want to add, edit or
delete words from your source material


You will see this if you select a number of words (by dragging the mouse over the words whilst holding the left
mouse button down). Search via a search engine for all the words in the lyrics, in a similar way to search above.


Presents Open (which allows you to open a text file and load the data in that file into your text field), and Save
(which allows you to save your text field to a text file).


Various options for copy/paste etc. as outlined above.


Presents Open (which allows you to open a text file and load the data in that file into your text field), and Save
(which allows you to save your text field to a text file).
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You can save your Liptikl session to a file with a .Liptikl file extension, through the File menu Save or Save As
options.


You can import a pre-existing lyric into Liptikl from a text file, with a .txt file extension, through the File menu
Export option. Note that the Import option requires each of your verses to be separated by at least one blank line.
If you try to import a large file, Liptikl might take a very long time to respond as it analyses the file; please be
patient! If you have a file in some format that is specific to a word-processor application, then you'll first have to
save the lyric as a text file before trying to import it into liptikl.


Once you've come up with a lyrical idea that you're happy with, you can export your generated lyrics to a text file,
with a .txt file extension, through the File menu Export option. You can then edit the file with your favourite word
processor application!
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